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Downloading Exercise Files 
Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 Click on the Resources tab as shown at the right. 

4 Under the Learning Series Books heading click on  Learning Excel 2010  

5 

Under the Exercise Files heading click on the underlined blue hyperlink, ie 

Learning Excel 2010 Free Download 
The File Download dialog box will display.   

6 If you have Winzip use the following instructions otherwise move to step 7. 

 a Click on . 

 
b Click on the  of the  button. 

 c If My Documents folder is not displayed click on Set default unzip folder at the bottom of 
the list.  Ensure My Documents is selected then click on Select Folder. 

 d  Click on the  of the  button and click on the My Documents folder.  The files will 
be unzipped. 

7 Click on and ensure My Documents folder is displayed.  Click on  

8 

Click on Open Folder which will display My Documents folder.  Right click on the zipped 
exercise file and select Extract All. Click on Extract.  A folder will be created containing the 
exercise files.   

You will need to double click on this folder to use the exercise files in this book. Sa
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Spreadsheet Theory 
The Excel Screen 
Opening and Exploring a Workbook 
Creating a New Workbook 

 
 
 

 
Learning Outcomes 
 
At the end of this section you should be able to -  
 

 Understand what a spreadsheet is 

 Start and exit Excel 2010 

 Understand the Excel 2010 screen 

 Open and explore an existing workbook 

 Create and save a new workbook 

 Enter text, numbers and formulas into a worksheet 

 Apply basic formatting to a worksheet 

 Print a worksheet 
  

Section 

1 
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Spreadsheets 
A spreadsheet is essentially a large working area composed of rows and columns.  The intersection 
of a row and column is called a cell.  Text and numbers are entered into these cells and formulas 
are used to manipulate the data to provide information required. 
 
Microsoft Excel 2010 (or any spreadsheet program) makes calculations easy - it replaces your 
pencil, paper and calculator.  If you change data in a worksheet, every formula associated with that 
data will be automatically recalculated accordingly. 
 
Data can therefore be altered to re-calculate budgets and to forecast results using different sales 
projections.  Worksheets can be saved on disk, retrieved and printed as required. 
 

In this book Microsoft Excel 2010 will be referred to as Excel 2010. 
 
 
Spreadsheets are widely used - 
 
1 In industry and commerce for 

• financial accounts 
• forecasting and projection results 
• recording and comparing data 
• personnel details 

 
2 At home for 

• budgeting 
• calculations, eg painting, wallpapering 
• savings and travelling expenses 

 
3 At schools for 

• test and examination results 
• timetables 
• school rolls 

 
4 At clubs for 

• membership fees 
• sports results 
• sponsorship details 

 
 
Examples of other spreadsheet programs include Lotus 1-2-3, Corel Quattro Pro and 
OpenOffice Calc (the last of which can be freely downloaded from the Internet). 
 

Spreadsheet/Worksheet 
The word spreadsheet is a general term for any document created by a spreadsheet program; a 
spreadsheet is referred to in Excel 2010 as a worksheet.  Both of these terms are used throughout 
this book but they refer to the same thing. 
  

Note 
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Samples of Spreadsheets 
 

 

 

 

 

 

 

 

 

 
 
 

 

 

 
 
 

 

Advantages of Spreadsheets 
• Calculations can be performed quickly and easily. 

• If data is altered, the calculations automatically adjust. 

• Worksheets within a workbook can be used for different groups of data.  Data from a group of 
worksheets can be calculated onto one summary worksheet. 

• Charts can be used to visually display data, eg bar, column, pie, line. 

• Data can be manipulated, grouped and sorted into a specific order for lists, databases, etc.  
Data within a spreadsheet can then be quickly located. 
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Starting Excel 2010 
Exercise 1 

1 Click on the Start button   at the bottom left-hand corner of the screen.    

2 Select   from the Start Menu.  

3 Select  from the Programs menu. 

 

4 Select   from the list to start Excel 2010.  
 
 
 

The Excel Screen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Office button  in Excel 2007 has been replaced with a File tab  which 
contains all basic tasks such as opening, saving and printing a spreadsheet. 

 

Active cell 

Name 
Box 

Column heading 

Vertical 
scroll bar 

Sheet tabs 

Title Bar Quick Access Toolbar Minimize 
Close 

Microsoft 
Excel Help 

Status Bar 

Ribbon 
 

Horizontal 
scroll bar 

Row 
heading 

Restore Down 

Note 

Formula Bar 

Tabs 

Sa
m

pl
e D

oc
um

en
t



© Cherylprice.co.nz Limited SECTION 1    5 

Quick Access Toolbar 
The Quick Access Toolbar contains commands to Save, Undo and Redo.  
Frequently used commands can be added to this menu.   
 

The Ribbon 
The toolbars and menus from Excel 2003 were replaced by the ribbon in Excel 2007 and is very 
similar in Excel 2010.  The ribbon provides access to all the tools required for working with a 
spreadsheet.   
 

 

 
  

Ribbon Tabs 
The ribbon has a series of tabs along the top; click on the tab to display the ribbon required.  There 
are seven default tabs: 

 

There are also hidden tabs that appear when appropriate, such as the Chart Tools.   These are 
displayed when you are working on a chart and disappear again when you have finished.   

 

 

 

Groups 
Ribbons are split into groups, (eg the Font Group).  Each group contains command buttons 
appropriate to a particular action; the font formatting tools are located in the Font Group. 

 

 
 

Clipboard 
Group 

Font 
Group 

Alignment 
Group 

Cells  
Group 

Editing 
Group 

Styles 
Group 

Number 
Group 
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Dialog Box Launcher 
The Dialog Box Launcher is the small diagonal arrow in the bottom right corner of some groups.  
When you click on this button, it displays an associated dialog box.   

Dialog boxes usually contain more settings or advanced features.  For example, the Number dialog 
box allows you to make formatting changes to the contents of the current cell. 
 

 
 

 
 

Key Tips 
The keyboard can be used to select tabs on the Ribbon and buttons on the Quick Access Toolbar.  
If you press Alt, Key Tips become active.   
 

 
 

These small badges are labelled with various letters and numbers, that when pressed on the 
keyboard, will trigger the associated command or function.  For example, to save the workbook 
press Alt and then 1.   
 

ScreenTips 
When you rest the mouse pointer over a button or command, 
a screen tip appears.  This is a small window describing the 
function of that command and any shortcut key it may have.   
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Opening a Workbook 
Exercise 2 

1 Click on the File tab  at the far left of the Ribbon.  When you click on the File tab 
Backstage view will appear.  This view allows you to create, open, print and save a 
workbook.  Excel options, accessing help along with exiting Excel are available in this view. 

2 Click on  to display the Open dialog box.   

3 Double click on the Learning Excel 2010 Exercise Files folder,ie 

. 

4 Select Fashion House.  Click on . 
 

If Protected View is turned on the following may appear.  Click on .  

 
 

Cell Contents 
Microsoft Excel allows you to enter data into any cell in a worksheet.  Data may consist of text, 
numbers or a formula based on selected cells. 

Various parts of a worksheet are shown below. 

 
 

 
(ie adds the values in cells C4 to C8) 

Labels 
Text/numbers that are not used in a mathematical formula or equation are called labels.  They help 
the reader understand different parts of a worksheet, ie column headings, row headings, title of a 
worksheet, etc. 
 
 

Values 
Data that is used to calculate results or the end result of a calculation. 

Formulas 
A mathematical equation using cell references/constraints to 
produce a result.  The result of a formula is seen in the worksheet; 
clicking on a cell will display the formula itself in the Formula 
Bar.  When values change, the result of the formula will be 
updated automatically in the worksheet.  
 

Ctrl O  

Formula Bar 

Note 

Labels  

Values 

=SUM(C4:C8) 
Formula 
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Exercise 3 

1 Click in the Name Box at the top left of the worksheet. 
 

 

2 Type: C9 

3 Press Enter.  The cursor will move to cell C9 within the current worksheet. 

The Formula Bar displays the formula that has been used to calculate the total for the 
America column.   

4 Double click on the selected cell (C9) to display the data range.  The data range displays cells 
that are included in the formula.   

 

5 Press Esc to turn off. 

6 Click on the File tab and click on .  If asked to save changes click on Don’t 
Save. 

The formula used to add the total for the America column can be broken down as follows. 
 

=SUM(C4:C8) 
 

Equal to 
To determine that this is a formula (equation) = is placed at the beginning of a formula. 

Function 
A built-in formula designed for ease of use.  Functions can perform tasks such as addition, 
calculating the average of a group of values, inserting the date, calculating angles, calculating the 
value of an investment over a period, etc.  (SUM will add together the contents of selected cells.) 

Range 
Reference to cells containing values, C4:C8 (ie C4 to C8).  The range is used instead of typing 
=C4+C5+C6+C7+C8 when using the SUM function. 
  

Equal to  

Range 

Function 

Data Range  

Name Box 

Ctrl W 
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Moving around a Worksheet 
Exercise 4 

In this exercise you will learn how to move the cursor around a worksheet, select cells, total 
columns/rows and create basic formulas.  

1 Click on  then click on .  Select the file called Wilson Markers found in the 
Learning Excel 2010 Exercise Files folder.  Click on Open. 

2 Practise cursor movements as described below. 

Cursor Movements 
 Keyboard Mouse 

A column at a time → or ← Move mouse and click  

A row at a time ↑ or ↓ Move mouse and click 

Beginning of a row  Home  Move mouse and click 

End of a row of data End → Move mouse and click 

Beginning of a row of data End ← Move mouse and click 

Down one window Page Down Point and click below vertical scroll box 

Up one window Page Up Point and click above vertical scroll box 

Cell A1 Ctrl Home Point and drag vertical scroll box up 

Bottom right corner cell of data Ctrl End Point and drag vertical scroll box down 

Next worksheet Ctrl Page Down Move mouse and click 

Previous worksheet Ctrl Page Up Move mouse and click 

Beginning and end of a row of 
data  

Ctrl → or ← Move mouse and click 

Beginning and end of a column of 
data  

Ctrl ↑ or ↓ Move mouse and click 

Across one window to the right Alt Page Down Point and drag the horizontal scroll box 
right 

Across one window to the left Alt Page Up Point and drag the horizontal scroll box 
left 

 

Scroll Bars 
The vertical and horizontal scroll bars at the right and bottom of the screen 
will move you around the worksheet area, beyond what you can initially 
see on your screen.  Click on the  at the bottom right of your screen, on 
the vertical scroll bar, to move down the worksheet.  Click on the  to 
move up the worksheet.  Click in the required cell to make that cell 
“active”. 

Dragging the scroll box on the vertical scroll bar will move quickly up or 
down the worksheet.  Use the horizontal scroll box at the bottom of the 
screen to move to the left or right of a worksheet. 
  

Ctrl O  

Scroll bar 

Scroll box 
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Selecting Cells 
Exercise 5 

Cells within a worksheet are selected to enter, edit or format data. 
 Practise selecting using the various methods shown below. 
 
Selecting Mouse 

Single cell Click in the centre of the cell.  
 
 
 
 
 
 

Range of cells Click in the first cell in the range and drag 
to the last cell in the range. 
 

Alternatively, click in the first cell, hold 
down the Shift key and click on the last cell. 
 
 
 

Non-adjacent cells Select the first range of cells then hold 
down the Ctrl key on the keyboard and 
select the second range of cells and so on. 
 
 
 
 
 

An entire column(s) Click on the column header  OR 
with the cursor in the column press Ctrl 
Spacebar. 
 

 
 

Adjacent columns 
Click and drag on the column headers.  
 
 
 

Non-adjacent columns 
Hold down the Ctrl key and click on each 
column header. 
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You can hold down the Shift key and use the arrow keys on the keyboard to select cells.  Pressing an 
arrow key (with the Shift key released) will deselect cells. 

 

Tip 

An entire row(s) Click on the row header  OR with the 
cursor in the row press Shift Spacebar. 

 

 

 

 

 

Adjacent rows 
Click and drag on the row headers. 
 
 
 
 
 
 
 
 

Non-adjacent rows 
Hold down the Ctrl key and click on each 
row header. 
 
 
 
 
 
 

Entire worksheet Click on the Select All button above the 
first row header and to the left of the first 
column header OR press Ctrl A.  

 

 

 

 

 

 

Deselecting 
selected cells 

Click in a blank cell outside the selected cells.  

 
 

 

Select All 
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The AutoSum Button 
The AutoSum button  is used for the addition of 
multiple cells in a worksheet.  It is located in the Editing group on 
the Home tab.   The drop-down arrow next to the AutoSum button 
is used to select other functions, eg average, maximum, etc. 
 
Before clicking on this button, ensure the active cell is where the result is to appear. 
 
The Sum function will look upwards from the cursor position 
(within a column) to find cells to add.  
 
However, if cells above a total cell do not contain values then the 
Sum function will look to the left of the cursor position and 
select cells to add (across a row). 

 
 
Exercise 6 

1 Click on cell D6. 

2 Click on  located in the Editing group on the Home tab (depending on your 
screen size this button may just display as ). 

 

Notice that the formula displays = (Equal to) indicating the start of a formula.  The SUM 
function adds the data in the cells indicated in the range.  Brackets are used to display the 
range to be totalled (from cell B6 to cell C6). 

3 Click on the Enter button  on the Formula Bar to insert the formula (or you can click on 
 again). 

4 Click on cell D7.  Use the AutoSum button again to calculate the total for row 7. 

5 Click on cell D8.  Click on .   

You will notice that Excel has selected the cells above the result cell (ie column D).  In this 
exercise we need the cells in row 8 to be calculated.   

Alt = 
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